
HP OpenView Performance Insight

Report Pack for Device Resources

Software Version 3.0

Reporting and Network Solutions
May 2004

 Copyright 2004 Hewlett-Packard Development Company, L.P.



Legal Notices

Warranty

Hewlett-Packard makes no warranty of any kind with regard to this document, including, but not limited to, 
the implied warranties of merchantability and fitness for a particular purpose. Hewlett-Packard shall not be 
held liable for errors contained herein or direct, indirect, special, incidental or consequential damages in 
connection with the furnishing, performance, or use of this material. 

A copy of the specific warranty terms applicable to your Hewlett-Packard product can be obtained from your 
local Sales and Service Office.

Restricted Rights Legend

Use, duplication, or disclosure by the U.S. Government is subject to restrictions as set forth in subparagraph 
(c)(1)(ii) of the Rights in Technical Data and Computer Software clause in DFARS 252.227-7013.

Hewlett-Packard Company
United States of America

Rights for non-DOD U.S. Government Departments and Agencies are as set forth in FAR 52.227-19(c)(1,2).

Copyright Notices

© Copyright 2002-2004 Hewlett-Packard Development Company, L.P., all rights reserved.

No part of this document may be copied, reproduced, or translated into another language without the prior 
written consent of Hewlett-Packard Company. The information contained in this material is subject to change 
without notice.

Trademark Notices

OpenView is a U.S. registered trademark of Hewlett-Packard Development Company, L.P. Windows®, and 
Windows NT® are U.S. registered trademarks of Microsoft® Corp. UNIX® is a registered trademark of The 
Open Group. 
2



Support

Please visit the HP OpenView web site at:
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Chapter 1
Overview

This chapter covers the following topics:

• OVPI and device resources

• Enhancements in Device Resources 3.0

• Integration with Network Node Manager

• Ways to customize reports

• Sources for additional information

OVPI and Device Resources

HP OpenView Performance Insight, commonly known as OVPI, is the operating environment 
for reporting solutions. Each reporting solution consists of a report pack and at least one 
datapipe. When you install the datapipe, you configure OVPI for data collection; when you 
install the report pack, you configure OVPI for data summarization and aggregation. Using 
the processing directives supplied by the datapipe and the report pack, OVPI manipulates the 
data, performs various calculations, and populates report templates with trending analysis. 

The Device Resources Report Pack monitors CPU, memory, and buffer resources in switches 
and routers. CPU, memory, and buffer resources tend to function independently. If a buffer is 
overutilized, the CPU that moves data in and out of the buffer could be underutilized. If the 
CPU is overutilized, buffer and memory could be underutilized. Device Resources does not 
monitor server resources. To monitor server resources, use the System Resources Report Pack.

If you run the Device Resources Report Pack and the Interface Reporting concurrently, there 
are synergies to exploit. If Interface Reporting is showing high discards or high errors, Device 
Resources will tell you whether or not overutilization of a resource might be causing the 
problem. Conversely, if Device Resources indicates that network response time is spiking, 
Interface Reporting will tell you whether interface utilization levels may be contributing to 
the problem.

Enhancements in Version 3.0

Device Resources 2.0 was released October 2003. Version 2.0 included the following 
enhancements:
7



Enhancements in Version 3.0
• New backplane utilization reports

— Historical Summary

— QuickView

— Snapshot

— Near Real Time QuickView

— Near Real Time Snapshot

• Update Thresholds form (for easier, faster changes to threshold values)

Device Resources 3.0 was released March 2004. The enhancements are as follows:

• Installs on OVPI 5.0 as well as OVPI 4.6

• If installed on OVPI 5.0, supports Oracle as well as Sybase

• Collects data from Cabletron devices (using the Dev Res Cabletron Datapipe)

• Upgrade package for customers running version 2.0 on Sybase

Folders and the Reports Inside

The Device Resources Report Pack contains 20 reports and the following folders:

• Customer

• Device

• Location

• Backplane

The following table shows what each folder contains. 

Report Type Customer Device Location Backplane

Exceptions Summary X

Card Historical Summary X

Historical Summary X X

Historical Summary Snapshot X

QuickView X

Snapshot X

NRT QuickView X X

NRT Snapshot X X

Forecast X X X

Service Level Management X

Summary X X

Top Ten X X X
8



Chapter 1
Collecting Data and Property Information

Some datapipes are vendor-specific and some are based on standards. The following vendor-
specific datapipes collect data for the Device Resource package:

• Dev Res 3COM Router Datapipe

• Dev Res Alcatel Xylan Switch Datapipe

• Dev Res Enterasys Router Datapipe

• Dev Res Enterasys Switch Datapipe

• Dev Res Cisco Switch Datapipe

• Dev Res Cisco Router Datapipe

• Dev Res Extreme Devices Datapipe

• Dev Res Foundry Datapipe

• Dev Res Dev Res HP ProCurve Datapipe

• Dev Res Nortel Bay Datapipe

In addition to performance data, reports contain the following kinds of property information:

• IP addresses and host names

• Customers

• Locations

Property information comes from tables maintained by the Common Property Tables package. 
If you are already running the previous version of Common Property Tables, you can preserve 
your existing property data by installing the upgrade package. This easy step is spelled out in 
detail in the next chapter.

If you are installing Common Property Tables 3.0 for the first time, you will not see customers 
or locations in reports until you import this data using either the batch-oriented import utility 
or the “create new” forms. The utility and the forms belong to the Common Property Tables 
package. For information about using the utility and the forms, see the Common Property 
Tables 3.0 User Guide. 

Integration with Network Node Manager

If you have already used the NNM/Performance Insight Integration Module to integrate NNM 
and OVPI, the reports in the Device Resources package will blend smoothly with the fault 
management capabilities of Network Node Manager. The NNM operator will see Device 
Resource reports in the Report Launchpad. The Report Launchpad window can be opened 
from NNM ovw, Home Base Dynamic Views, and the NNM alarm browser.

Device Resources 3.0 includes an optional thresholds sub-package. If you install it, the OVPI 
server will send threshold traps to the NNM server. A trap from the OPVI server will show up 
as an alarm in the NNM Alarm Browser. By selecting the alarm, the NNM operator can 
display a report containing data about the node that caused the alarm. 
9



Ways to Customize Reports
If you install the optional thresholds sub-package, the Package Manager install wizard will 
automatically install the Threshold and Event Generation Module, also known as the 
Thresholds Module. If desired, you may configure the Thresholds Module. For product details, 
including information about the latest enhancements, refer to the Thresholds Module 5.0 User 
Guide.

Ways to Customize Reports 

The contents of a report can be customized by applying group filters, by editing parameters, 
by editing tables and graphs, and by importing node names, customers, and locations. If you 
apply a group filter, your goal is to change how the entire package appears to a particular 
group of users. When you edit a report, you are making a temporary change. For more about 
editing tables and graphs, see Chapter 9, Editing Tables and Graphs.

Group Filters

If you intend to share your reports with customers, or let divisions within your enterprise see 
division-specific performance data, you will want these reports to be customer-specific, 
containing data limited to one customer. Creating customer-specific reports is an 
administrator task that involves the following steps:

• Importing customer names and device locations using Common Property Tables 

• Creating a group account for all of the users affiliated with a particular customer

• Creating a group filter for the group account

For more information about creating filters for group accounts, refer to the OpenView 
Performance Insight 5.0 Administration Guide. 

Report Parameters

If you edit a parameter, you are applying a constraint to the report with the intention of 
eliminating data you do not want to see. For example, if you edit the Customer Name 
parameter, data for every customer except the customer you typed in the Customer Name 
field will drop from the report. If you edit the Source Location, data for all locations except the 
location you typed in the Source Location field will drop from the report. 

Constraining the contents of a report by editing parameters is completely optional and you 
may apply multiple constraints at once. Device Resources supports the following parameters: 

• Customer Name

• Customer ID

• Location Name

• Location ID

• Device Name

• Make

• Model
10



Chapter 1
Some reports support every parameter in this list, while most reports support a subset of this 
list. To edit parameters, click the Edit Parameters icon at the bottom right-hand corner of the 
report. When the Edit Parameters window opens, type the constraint in the field and then 
click Submit.

Sources for Additional Information

The following user guides are related to this manual: 

• Common Property Tables 3.0 User Guide

• PI/NNM Integration Module 2.0 User Guide

• System Resources Report Pack 4.0 User Guide

• Thresholds Module 5.0 User Guide 

The following release statements are related to this manual: 

• Device Resources Report Pack 3.0 Release Statement

• Dev Res 3COM Router Datapipe Release Statement

• Dev Res Alcatel Xylan Switch Datapipe Release Statement

• Dev Res Cabletron Datapipe Release Statement

• Dev Res Cisco Switch Datapipe Release Statement 

• Dev Res Cisco Router Datapipe Release Statement 

• Dev Res Extreme Devices Datapipe Release Statement

• Dev Res Foundry Datapipe Release Statement

• Dev Res Nortel Bay Datapipe Release Statement 

• Dev Res HP ProCurve Datapipe Release Statement 

Manuals for the core product, OVPI, and manuals for the reporting solutions that run on 
OVPI, are posted to the following website:

http://support.openview.hp.com/support

Select Technical Support > Product Manuals to reach the Product Manuals Search page. The user 
guides for the core product, Performance Insight, are listed under Performance Insight. The 
user guides for report packs, datapipes, preprocessors, and SPIs for NNM are listed under 
Reporting and Network Solutions. 

Each manual listed under Reporting and Network Solutions indicates the month and year of 
publication. Because revised user guides are posted to this site on a regular basis, from 
time to time you should check this site for updates. If your PDF has been superseded, 
download the latest PDF.
11
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Chapter 2
Package Installation

This chapter covers the following topics:

• Guidelines for a smooth installation

• Using Package Manager to install Device Resources

• Removing the Device Resources package 

Guidelines for a Smooth Installation

The RNS 5.0 CD includes NNM components as well as OVPI components. Once you select 
OVPI report packs for extraction, the install script copies every OVPI package on the CD to 
the Packages directory on your system. If the OVPI packages on the RNS 5.0 CD have already 
been extracted, you may install Device Resources 3.0 by launching the Package Manager 
install wizard and following the familiar on-screen directions. 

If you are currently running Device Resources 2.0, you may upgrade to version 3.0 by 
installing the upgrade package for Device Resources 2.0. However, in addition to installing 
the upgrade package for Device Resources 2.0, you also need to upgrade Common Property 
Tables, remove old datapipes, and install new datapipes. Follow these steps to upgrade from 
Device Resources 2.0 to Device Resources 3.0:

1 Install the upgrade package for Common Property Tables; deploy reports.

2 Remove existing datapipes.

3 Install the upgrade package for Device Resources 3.0; deploy reports.

4 Install new datapipes. 

Software Prerequisites

Version 3.0 of Device Resources has the following prerequisites:

• OVPI 4.6, with all available Service Packs; or

• OVPI 5.0, with all available Service Packs

• Common Property Tables 3.0 
13



Guidelines for a Smooth Installation
If you are not currently running any version of Common Property Tables, let Package 
Manager install version 3.0 for you. If you are running the previous version of Common 
Property Tables, upgrade from version 2.2 to version 3.0. Installing the upgrade package for 
Common Property Tables is easy. However, if you need assistance or if you want to know more 
about how this package operates, refer to the user guide.

Datapipes

The datapipes that collect data for this report pack are not prerequisites. You may install the 
datapipes when you install the report pack or you may install the datapipes after you install 
the report pack. The following datapipes are available:

• Dev Res 3COM Datapipe

• Dev Res Alcatel Datapipe

• Dev Res Cabletron Datapipe

• Dev Res Cisco Switch Datapipe

• Dev Res Cisco Router Datapipe

• Dev Res Enterasys Router Datapipe

• Dev Res Enterasys Switch Datapipe

• Dev Res Extreme Devices Datapipe

• Dev Res Foundry Datapipe

• Dev Res Nortel Bay Datapipe

• Dev Res HP ProCurve Datapipe

Installing at least one datapipe is mandatory. There are no upgrade packages for datapipes, so 
you should always remove an existing datapipe before installing the latest version of the same 
datapipe. 

Thresholding and Integration with Network Node Manager

If you have already integrated OVPI with NNM, you may install the thresholds sub-package, 
Device_Resource_Thresholds. This optional package contains customized thresholds. If you 
install it, the threshold traps generated by OVPI will display as alarms in the NNM alarm 
browser. 

If you select the thresholds sub-package for installation, Package Manager will install the 
Thresholds Module for you, automatically. The Thresholds Module controls the actions taken 
in response to a threshold breach. For details about the latest enhancements to the 
Thresholds Module, refer to the Thresholds Module 5.0 User Guide. 

Distributed Environments

If you intend to run Device Resources in a distributed environment, the installation is more 
complex. Here is an overview of the steps:

1 Make sure that every server is running the same version of OVPI.

2 Make sure that every server is running all available Service Packs for OVPI. 
14



Chapter 2
3 Disable trendcopy on the central server.

4 Install the following packages on the central server:

• Device Resources; deploy reports 

• Thresholds sub-package

• Common Property Tables 3.0; deploy reports

5 Install the following packages on each satellite server:

• Device Resources; deploy reports

• Common Property Tables 3.0

• At least one datapipe

6 Re-enable trendcopy on the central server.

After installing Device Resources in a distributed environment, use the Management Console 
to set up connections between the central server and satellite server databases. In addition, 
you must edit a file that controls how the central server pulls data from each satellite server. 
These tasks are covered in Chapter 3, Package Configuration.

Installing Device Resources

Insert the RNS 5.0 CD. On Windows, a menu with installation options appears automatically; 
on UNIX, mount the CD, navigate to the top level directory on the CD, and run the ./setup 
command. When the menu appears, select OVPI Report Packs for installation. 

After the install script has copied every package to the Packages directory on your system, you 
will be prompted to start the Package Manager install wizard. If you just extracted OVPI 
packages from the CD and the Package Manager install wizard is running, begin the following 
procedure at step 5; otherwise, begin at step 1.

1 Log in to the system. On UNIX, log in as root.

2 Stop OVPI Timer and wait for processes to terminate.

Windows NT: Select Settings > Control Panel > Administrative Tools > Services

UNIX: As root, type one of the following:

HP-UX: sh /sbin/ovpi_timer stop

Sun: sh /etc/init.d/ovpi_timer stop

3 Select HP OpenView > Performance Insight > Management Console.

4 Select Tools > Package Manager. The Package Manager welcome window opens.

5 Click Next. The Package Location window opens.

6 Click the Install radio button. Approve the default destination directory or browse to a 
different directory if necessary. 

7 Click Next. The Report Deployment window opens.

8 If you are deploying reports, type your OVPI username and password. 

9 Click Next. The Package Selection window opens. Click the check box for at least one 
datapipe; click the check box for the following packages:
15



Installing Device Resources
Device Resource 3.0

Device Resource Thresholds [optional]

Device Resources Demo Package [optional]

10 Click Next. The Type Discovery window opens. To run Type Discovery immediately after 
package installation, accept the default and click Next. The Selection Summary window 
opens.

11 Click Install. The Installation Progress window opens and the install begins. When the 
install finishes, a package installation complete message appears.

12 Click Done to return to the Management Console. 

13 Restart OVPI Timer.

Windows NT: Select Settings > Control Panel > Administrative Tools > Services

UNIX: As root, type one of the following:

HP-UX: sh /sbin/ovpi_timer start

Sun: sh /etc/init.d/ovpi_timer start

The reports in the demo package are static—the data will not change from day to day—but 
the linking between tables and graphs works and you can experiment with view options (also 
known as edit options) for individual tables and graphs. 

Options for Viewing Reports

Before reports can be viewed using a web browser, they must be deployed. When you installed 
Device Resource, you enabled the Deploy Reports option. As a result, Device Resource reports 
are deployed to the Application Server and are available for viewing on the web. 

If the client component of OVPI was installed on your system, you have access to Report 
Viewer, Report Builder, and the Management Console. If the client component was not 
installed on your system, web access to reports is your only means of access. 

For more information about the client component, refer to the HP OpenView Performance 
Insight 4.6 Installation Guide. For more information about the Management Console, 
including how to use the Object Manager to launch reports specific to selected objects, refer to 
the Performance Insight 5.0 Administration Guide.

Seeing Performance Data 

Some reports populate with data sooner than others. The first report to populate with data is 
the Near Real Time report. You will begin to see data in this report immediately after the first 
data collection completes. 

Any report that begins with an analysis of yesterday’s performance will need at least one full 
day’s worth of data before results are viewable. You will begin to see forecast data soon, within 
a few days. However, reliable forecast data will not be available until the rolling baseline is 
complete, and that will take about six weeks.
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Chapter 2
Removing the Device Resources Package

When you uninstall a report pack, the tables associated with the report pack, as well as all the 
data in those tables, are deleted. If you want to preserve the data in those tables, archive the 
data before uninstalling the package.

Removing Device Resources automatically removes any datapipe that depends on Device 
Resources. Follow these steps to uninstall the Device Resources package.

1 Log in to the system. On UNIX systems, log in as root.

2 Stop OVPI Timer and wait for processes to terminate.

3 Select HP OpenView > Performance Insight > Package Manager. The Package Manager 
welcome window opens. Follow the on-screen directions for uninstalling packages. When 
the uninstall process finishes, a package removal complete message appears.

4 Click Done to return to the Management Console.

5 Restart OVPI Timer.
17
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Chapter 3
Package Configuration

This chapter covers the following topics: 

• Configuring servers in a distributed system

• Default thresholds for exceptions

• Using the change form to modify thresholds

Skip the next section if:

• You are running Device Resources on a stand-alone system

• You were running version 2.0 as a distributed system and you upgraded to version 3.0

Configuring Servers in a Distributed System

If you intend to run Device Resources 3.0 as a distributed system, you need to install packages 
on the central server, install packages on each satellite server, configure the central server, 
and configure each satellite server. If you followed the advice in Chapter 2, Installation, you 
installed the following packages on the central server —

• Device Resources

• Thresholds sub-package [optional]

• Thresholds Module [optional]

• Common Property Tables

— and you installed the following packages on each satellite server:

• Device Resources

• Thresholds sub-package [optional]

• Thresholds Module [optional]

• Common Property Tables 

• At least one datapipe

Configuring the Central Server

Perform these tasks to configure the central server:
19



Configuring Servers in a Distributed System
• Task 1: Set up connections with satellite server databases

• Task 2: Configure trendcopy pull commands for hourly data

• Task 3: Configure trendcopy pull commands for rate data (optional)

Task 1: Set up connections with satellite server databases

1 Select HP OpenView > Performance Insight > Management Console.

2 Click the Systems icon on the lower left. The System/Network Administration pane opens.

3 Right-click the Databases folder. When prompted, select Add OVPI Database. The Add 
Database Wizard opens. 

4 Click Next.

5 Type the hostname and port number for the database you want to add; click Next.

6 Review the Summary. Repeat Steps 4 and 5 for each additional database.

7 Click Finish when you are done. 

Task 2: Configure trendcopy pull commands for hourly data

1 Open the following file:

$DPIPE_HOME/scripts/DeviceResourceReporting_hourly.pro

2 Uncomment the copy commands in the hourly_copy block.

3 Modify the copy commands in the hourly_copy block as follows:

• Replace SATELLITE_SERVER_1_DATABASE with the satellite server name

• Replace THIS_MACHINE_DATABASE with the central server name

4 If there is more than one satellite server, create and configure new hourly copy commands 
for each additional machine. 

Task 3: Configure trendcopy pull commands for rate data (optional)

If you want to view Near Real Time reports on the central server, rate data must be available 
on the central server. Follow these steps to pull rate data from satellite servers:

1 Add more trendcopy commands by replicating the existing trendcopy commands.

2 Make the following modifications to replicated trendcopy commands:

• Change SHDevRes_Device to SRDevRes_Device

• Change SHDevRes_DeviceMem to SRDevRes_DeviceMem

• Change SHDevRes_DeviceCard to SRDevRes_DeviceCard 

3 Comment out the hourly trendsums in the DeviceResourceReporting_Hourly.pro file.

4 Open the following file:

$DPIPE_HOME/scripts/DeviceResourceReporting_hourly.pro

5 Uncomment the copy commands in the rate_copy block

These tasks apply to new installations only. If you just upgraded to Service 
Assurance 3.0, and your servers were already configured to operate as a 
distributed system, those settings are still in effect. 
20



Chapter 3
6 Modify the copy commands in the rate_copy block as follows:

• Replace SATELLITE_SERVER_1_DATABASE with the satellite server name

• Replace THIS_MACHINE_DATABASE with the central server name

7 If there is more than one satellite server, create and configure new hourly copy commands 
for each additional machine. 

Configuring Satellite Servers

Follow these steps to configure a satellite server.

1 Disable daily aggregations:

• Open the $DPIPE_HOME/lib/trendtimer.sched file.

• Comment out lines referencing DeviceResourceReporting_Daily.pro

2 Change the default that determines when hourly processing begins; make hourly 
processing begin sooner:

• Open the $DPIPE_HOME/lib/trendtimer.sched file. 

• Locate the OVPI timer entry in the DeviceResourceReporting_Hourly.pro file. By 
default, hourly processing begins at 40 minutes after the hour. 

• To make sure the satellite server completes hourly summarizations before the central 
server begins hourly summarizations, change the start time from 1:00+40 to 1:00+25.

3 Configure datapipe polling policies; make sure that each network device is polled by one 
satellite server only.

4 If the satellite server has two or more pollers, create separate polling policies for each 
poller and use views and types to separate the devices.

5 If remote pollers are being used, be sure to avoid duplicate polling across the pollers and 
duplicate polling between the satellite and the pollers.

6 Verify that the system clock on the satellite server is synchronized with the system clock 
on the central server.

Default Thresholds for Exceptions

The Device_Resource_Thresholds sub-package imposes an exception threshold on CPU 
utilization, memory utilization, and buffer utilization. When performance reaches one of these 
defaults, the thresholds sub-package sends a trap to the network management system. 

Copying rate data from satellite servers every hour has two 
unpleasant side-effects: it increases traffic between servers, and it 
increases the load on the central server.

This steps are not applicable to you if (1) the satellite server is performing 
local reporting, or (2) the thresholds sub-package is not installed on the 
satellite server.
21



Using the Change Form
The following table describes the condition behind each threshold breach and the severity of 
the alarm sent in response to the breach.  

No intervention on your part is necessary to enable the exception threshold values in the 
preceding table. However, if you want to enable multiple types of traps, or set up multiple trap 
destinations, you need to configure the Thresholds Module. For details, refer to the Thresholds 
Module User Guide. 

Using the Change Form

Device Resources 3.0 provides a form for modifying default thresholds. Follow these steps to 
launch the Update Thresholds form:

1 Click the Objects icon in the panel on the left side of the Management Console window. 
The Object/Property Management view opens. 

Object Manager shows a list of objects. The type of object presented depends on which 
Object Manager View is open:

• The Device view (the default) shows a list of devices

• The Customer view shows a list of customers

• The Location view shows a list of locations

2 To change the view, select View > Change View and use the pop-up window to select a 
different view. 

3 Once you see the type of object you are interested in updating, select the particular object 
you would like to update. Object Specific Tasks appears in the window on the right. 

4 Double-click the task to open the Update Thresholds form, shown below.

Metric Threshold Severity

CPU 85% Medium

Memory 85% Medium

Buffer 85% Medium
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Chapter 4
Top 10 Reports

Device Resources contains three Top Ten reports:

• Customer Top Ten

• Device Top Ten

• Location Top Ten

Use these reports to identify which customers, locations, and devices rank worst in terms of 
CPU, memory, and buffer utilization. The customer report aggregates statistics for groups of 
devices belonging to one customer, while the location report aggregates statistics for groups of 
devices at various locations belonging to one customer. The device report does not aggregate 
data. It displays statistics for the individual devices belonging to one customer. 

In addition to ranking customers, locations, or devices, each Top Ten report also sorts items by 
highest F90 value, the utilization level that OVPI predicts will be in effect 90 days from today. 
Note that left and right tables are independent and that an item appearing in the worst 
performing table on the left may not appear in the forecast table on the right. If the same item 
appears in both tables, you can assume that yesterday’s performance is part of a longer-term 
trend that may call for corrective action.

The tables on the left provide statistics for yesterday’s average utilization and yesterday’s 
busy hour. Table entries sort according to average utilization, highest to lowest. The tables on 
the right provide statistics for baseline, F30, F60, and F90; table entries sort by F90 value, 
highest to lowest. Baseline here means average busy hour. 

The Device Top Ten begins with a customer summary table that sorts customers by resource 
utilization, highest to lowest. The Customer Top Ten and the Location Top Ten begin with a 
customer exception count table that sorts customers by yesterday’s total exception count, 
highest to lowest. 

See below for samples of all three Top Ten reports.
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Chapter 5
Summary Reports

Summary reports focus on groups of devices rather than individual devices. If a graph 
monitors utilization for all the devices belonging to one customer, or all the devices in one 
location, you are looking at a summary report. If a graph provides hourly and daily data, and 
the samples that constitute the hourly value and the daily value are based on averages, again 
you are looking at a summary report. 

The customer summary report focuses initially on the threshold exception count for specific 
customers. Customers sort by the number of exceptions, highest to lowest. The graphs below 
track CPU, memory, and buffer utilization. A bar chart displays the exception count hour-by-
hour and day-by-day, while the Grade of Service chart provides an overall score for the 
customer, hour-by-hour and day-by-day. Use the Customer Summary to look at resource 
utilization customer by customer. 

The location summary is exactly the same as the customer summary, except for the location 
selection table providing an exception count for all the locations belonging to one customer. 
The graphs look at resource utilization for all the devices in one specific location. A bar chart 
displays the exception count hour-by-hour and day-by-day for this location, while the Grade of 
Service chart provides an overall score for this location on an hourly and daily basis.

The historical summary reports focus initially on busy hour and then provides detailed 
analysis, in the form of hourly and daily aggregations, for individual devices or individual 
cards on one device. The first table sorts customers by aggregated busy hour, highest to 
lowest, allowing you to easily compare one customer to another. Select a customer to populate 
a table of devices belonging to that customer, sorted by resource utilization, highest to lowest. 
Select a device to populate a frequency distribution pie chart and graphs that track average 
and maximum utilization for CPU, memory, and buffer. Here, maximum utilization is a single 
sample, specifically, the highest sample for the hour or for the day, not an average of multiple 
samples. 

Like the historical summaries, the exception summary is device-specific. This report 
focuses initially on exception counts per customer. Select a customer to populate a table 
showing which devices were responsible for those exception counts. Use the hourly graphs to 
find out exactly when those exceptions took place. Compare the hourly graph to the daily 
graph to find out whether yesterdays exception count is an isolated incident or part of a 
longer-standing trend.

See below for samples of all six summary reports, including the backplane historical 
summary.
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Chapter 6
Forecast Reports

The three forecast reports in Device Resources focus on Days to Threshold (DTT) and provide 
estimates for future utilization. The threshold is 90% utilization, and the value for DTT 
indicates how close the device is to reaching 90% utilization. 

The customer and location reports are actually summary reports, aggregating data by 
customer or by location. The DTT values in these reports are actually averages across all 
devices for that customer, or all devices in that location. For example, if the memory 
utilization DTT is 17 for a customer, many devices could be closer to the threshold while many 
devices could be further away from the threshold.

If you want to see which customer is closest to a threshold, or which location is closest to a 
threshold, start with the summary reports. If a customer or device looks suspicious, use the 
device report to pinpoint the devices that appear to be causing the problem. The device report 
provides DTT and forecasts for specific devices; the data is not aggregated.

All three reports use the same criterion for inclusion: a customer, location, or device appears 
in the report if CPU, buffer, or memory utilization is expected to exceed the exception 
threshold sometime within the next 90 days. The three graphs under the DTT data allow you 
to find out which resource is contributing to the problem. Each graph has three tabs:

• Standard

• Day of Week

• History

Use the standard graph to compare the baseline (average busy hour during the baseline 
period) to F30, F60, and F90. Use the day of week graph to compare the baseline to F30, F60, 
and F90 on a day of week basis and to find out whether resource usage is correlating with a 
particular day of the week. Use the history graph to compare average utilization to busy hour 
utilization over the baseline period. In the hourly graph, “average utilization” is based on four 
samples. In the daily graph “average utilization” is based on 96 samples (4 samples per hour, 
24 hours per day).

The F30, F60, and F90 values are produced by applying linear regression to busy hour values 
recorded over the baseline period. Busy hour is the highest average utilization for the day.   
During that hour, actual utilization may have been considerably higher for at least a portion 
of the hour. Busy hour reflects a persistent event, not a momentary spike. When busy hour is 
high, you want average utilization to be low. If average utilization is high, you know that 
resource utilization has been high for an extended period of time.
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Chapter 7
Service Level Management

The Service Level Management report focuses on the availability of individual devices and 
network response time. Use this report to see if availability and network response time are 
meeting levels guaranteed by service level agreements.

An available device is a device that returns a request from the polling agent. The calculation 
that determines availability has limitations. Although it can compensate for network issues 
that may prevent the device from responding to a polling request, it cannot tell the difference 
between a device that is down and a device that is busy and not able to respond. Given this 
limitation, you may want to use the availability statistics in this report as one indicator of 
device availability, not your only indicator of device availability.

Network response time is defined as the length of time that elapses from the moment a 
request is sent by the datapipe to the moment the answer is received by the datapipe. This 
perspective on response time is different from the user’s perspective. Since the perspectives 
are different, you should interpret response time increases as an indicator that traffic may be 
congested and that the delay experienced by users may be comparable.

Selecting a customer from the customer list populates two tables:

• Devices sorted by availability

• Devices sorted by network response time

The first table sorts devices by availability, highest to lowest. The second table sorts devices 
by busy hour, highest to lowest. 

Selecting a device populates two graphs:

• Device availability, hourly and daily

• Average network response time vs. busy hour network response time

The hourly view of device availability covers a 24-hour period, midnight to midnight. The 
daily view begins with yesterday and covers the previous two weeks. If you see low 
availability, or high response time, compare yesterday’s performance with performance over 
the past two weeks to see whether yesterday’s performance is in line with recent history or 
different from recent history.
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Near Real Time Reports

The two Near Real Reports in Device Resources—the QuickView and the Snapshot version of 
the QuickView—shed light on resource utilization over the last six hours and the last 24 
hours. The selection table at the top of the report focuses on the last six hours and sorts 
devices by resource utilization, highest to lowest. It displays average utilization for CPU, 
memory, and buffer, using for input all the samples taken during the last six hours. In 
practice, this means approximately 24 samples. If samples are taken every 15 minutes, then 
the most recent sample in this average is only several minutes old. 

While the table at the top of the report provides averages for the previous six hours, the CPU, 
memory, and buffer graphs monitor activity over the previous 24 hours. In OVPI speak, you 
are looking at rate data, that is, the actual samples, not hourly averages. You also have a 
grade of service chart that ranks service quality over the last six hours. Since the Near Real 
Time report is recalculated after every poll, you can use this chart to find out whether a 
situation you are watching closely is improving or getting worse.

Because the table at the top highlights devices with the worst utilization, you can use the 
NRT QuickView to identify which devices are in trouble—or confirm that no devices are in 
trouble. In addition, if an average in the table seems abnormal, you can compare the average 
in the table to the previous 24 hours to see if the current average represents an existing 
condition or a completely new condition. If a summary report for yesterday points to a 
situation that could become problematic, the Near Real Time report will tell you whether that 
condition is improving, worsening, or staying about the same. The good news is that you have 
some advance warning and you should be able to correct the problem before it becomes a 
serious issue for users. 

Due to space limitations, the time period in the three rate data graphs may be partially 
concealed. You can easily improve your view of the data by right-clicking the graph, selecting 
View in New Frame, and resizing the window. Once resized, every hour will be clearly 
visible. 

The Snapshot version of the Near Real Time QuickView operates just like the Snapshot 
version of the Historical Summary. Launch it, then respond to the prompts that ask you which 
device or devices you want to include in the report. If a summary, top ten, or forecast report 
has already alerted you to a device with resource problems, and this device is not appearing in 
the NRT QuickView, you can launch the Snapshot version to see where utilization levels are 
right now and what has happened since yesterday.

Samples of QuickView NRT, QuickView NRT Snapshot, and Backplane NRT follow.
55



56



Chapter 8
57



58



Chapter 8
59



60



Chapter 9
Editing Tables and Graphs

Any table or graph can be viewed in several ways. While the default view is usually fine, you 
can easily change to a different view. If you are using Report Viewer, change the default view 
by right-clicking the object and selecting a different view. If you are viewing the report on the 
Web, click the Edit Table or Edit Graph icons. 

View Options for Tables

Right-clicking a table, or selecting Edit Table, opens a list of table view options.

Select Set Time Period to alter the relative time period (relative to now) or set an absolute 
time period. The Set Time Period window opens.

You may shorten the period of time covered by the table from, for example, 42 days to 30 days 
or to 7 days. If you are interested in a specific period of time that starts in the past and stops 
before yesterday, click Use Absolute Time and select a Start Time and an End Time.
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View Options for Tables
Select Change Constraint Values to loosen or tighten a constraint, thereby raising or 
lowering the number of elements that conform to the constraint. The Change Constraint 
Values window opens. To loosen a constraint, set the value lower; to tighten a constraint, set 
the value higher.

The Select Nodes/Interfaces allows you to change the scope of the table by limiting the 
table to specific nodes, specific interfaces, or a specific group of nodes or interfaces. The Select 
Node Selection Type window opens.
Change Max Rows increases or decreases the number of rows in a table. The default is 50. If 
you expand the default, the table may take more time to open. If you are trending a large 
network, using the default ensures that the table opens as quickly as possible. 
 View in new Frame opens the table in a Table Viewer window, shown below. If necessary, 
make the data in the table more legible by resizing the window. 
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View Options for Graphs

Right-click any graph to open a list of view options. 

The following table provides a few details about each option.

Option Function

Set Time Period Same as the table option shown above.

Change Constraint Values Same as the table option shown above.

Select Nodes/Interfaces Same as the table option shown above.

Displayed Data For every point on a graph display data in a 
spreadsheet.

Grid Add these to the graph:
X axis grid lines
Y axis grid lines
X and Y axis grid lines

Legend Delete or reposition the legend. 

Style See the illustrations below.

Change Max Rows... Same as the table option shown above.

Display Data Table See below.

Export Element as CSV... Same as the table option shown above.
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View Options for Graphs
Style Options

Select Style to display a list of seven view options for graphs.

Style > Area

The plot or bar chart changes to an area graph. While relative values and total values are 
easy to view in this format, absolute values for smaller data types may be hard to see. Click 
anywhere within a band of color to display the exact value for that location 

View in New Frame Opens graph in a Graph Viewer window.

Print Graph Same as the table option shown above.

Option Function
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To shorten the time span of a graph, press SHIFT+ALT and use the left mouse button to 
highlight the time span you want to focus on. Release the mouse button to display the selected 
time span.

Style > Stacking Area

The area or plot graph changes to a stacking area graph. This view is suitable for displaying a 
small number of variables.

Style > Bar

The graph changes to a bar chart. This view is suitable for displaying relatively equal values 
for a small number of variables. There are three variables in the graph below.
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View Options for Graphs
Style > Stacking Bar

The plot or area graph changes to a stacking bar chart. If you increase the width of the frame, 
the time scale becomes hourly. If you increase the height of the frame, the call volume shows 
in units of ten.

Style > Plot

Bands of color in an area graph change to lines. If you adjust the frame width, you can make 
the data points align with hour; if you adjust the frame height, you can turn call volume into 
whole numbers.
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Style > Pie

An area graph becomes a pie chart. Bands in an area graph convert to slices of a pie and the 
pie constitutes a 24-hour period. This view is helpful when a small number of data values are 
represented and you are looking at data for one day.

If you look at data for more than one day, you will see multiple pie graphs, one for each day. 

Display Data Table

This option changes a graph into a spreadsheet. 
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View Options for Graphs
View in New Frame

The graph opens in a Graph Viewer window. Make this graph easier to see, and display more 
details along the x axis, by resizing the window. 
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Availability

The percentage of time the device is operational. This measurement accounts for outages indicated 
by the sysUpTime variable; however, it does not account for periods of time the device could not be 
reached by OVPI.

Average utilization

In an hourly graph, this value is an average of four samples taken over a one-hour period. In a daily 
graph, this value is an average of 96 samples taken over a 24-hour period.

Baseline

The average busy hour over the baseline period. Rate of growth, a statistic that appears in forecast 
reports, is calculated by dividing F30 by the average busy hour.

Baseline period

The previous 91 days. Forecasts for F30, F60, and F90 are based on performance during the 
baseline period.

Buffer utilization exception

Recorded when buffer utilization exceeds the allowable threshold.

Buffer utilization threshold

When buffer utilization is above this value, an exception is raised. The default value for the 
threshold is 85%.

Busy Hour

The definition varies depending on what is being measured. Busy hour is either a busy hour total, or 
a busy hour average. A busy hour total points to the hour of the day that recorded the highest 
number of events, for example, the highest number of discards or the highest number of errors. In 
Device Resources, busy hour is the highest hourly average for the day. Busy hour is a relatively 
persistent event. Do not confuse busy hour with peak, a momentary event. Since busy hour is an 
average, you may assume that actual utilization could have been significantly higher or lower 
during the course of that hour. Busy hour average refers to the highest average hour among 24 
hourly averages; this term is synonymous with busy hour. Average busy hour refers to an average 
of all busy hour values over the baseline period and is synonymous with baseline.

Card

Whether or not performance information at the card level is available depends on the make and 
model of the device. Some vendors maintain a distinction between CPU and card and some do not. 
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Vendors who do maintain the distinction may not maintain it uniformly across all equipment. The 
card selection table in the card historical summary report may contain just one entry or it may 
contain multiple entries. If you see just one entry, it is possible that the device contains just one 
card, or it could indicate that the device is not able to report multiple cards. If the device cannot 
report multiple cards, the statistics that display at the card level are exactly the same as the 
statistics that display at the device level.

Common Property Tables

Customer names can appear in reports if you import customer names using the Common Property 
Tables package. As explained in the Common Property Tables User Guide, two methods of property 
import are available, a batch-oriented property import utility, and a series of forms for creating and 
updating customer, locations, and nodes. If you do not import customer names, data from every 
customer will roll up under All Customers If you do no import locations, data for all locations will 
roll up under All Locations.

CPE utilization exception

Recorded when CPU utilization exceeds the allowable threshold.

CPU utilization threshold

When CPU utilization exceeds this value, an exception is raised. The default value for the threshold 
is 85%. 

Daily

A view of performance that compares average utilization to busy hour utilization. The number of 
days that you can see in this view depends on the number of days that data has been collected. The 
maximum number of days is the rolling baseline, 91 days. Note that daily views also include 
performance data from yesterday, the same data currently visible in the hourly view, rolled up as 
one average and one busy hour.

Days to Threshold (DTT)

The number of days that will elapse before utilization is expected to reach 90%. Device Resources 
calculates DTT for CPU utilization, memory utilization, and buffer utilization.

Device

A router or a switch; not a server. In selection tables, devices are listed by IP address or hostname. 

Grade of Service

A total score based on a combination of contributing scores, sometimes equally weighted, 
sometimes not. In Device Resources the GOS is equally-weighted and it combines scores for 
memory, buffer, and CPU as follows: 

GOS =  GOS memory +  GOS buffer +  GOS CPU

Hourly

An average derived from four collections taken once every 15 minutes; also a graph showing 
yesterday’s hourly increases and decreases. 

1
3
--- 1

3
--- 1

3
---
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Memory utilization exception

Recorded when memory utilization exceeds the allowable threshold.

Memory Utilization threshold

When memory utilization exceeds this value, an exception is raised. The default value is 85%.

Near Real Time

An average for performance over the previous six hours, ending with the most recent poll. If polling 
takes place 4 times an hour, the NRT average is derived from 24 samples. The NRT average is a 
rolling average and it is recalculated at the conclusion of each poll. 

Network response time

The time that elapses from the moment the poller sends an SNMP request to a device to the 
moment the poller receives a response from the device. 

Summary

An aggregation of multiple samples. In an hourly graph, an average based on multiple samples 
collected during one hour; in a daily graph, an average based on multiple samples collected over the 
course of each day. In customer and location reports, an aggregation of multiple averages for 
multiple devices across the same hour, the same day, or the same month.

Utilization

Utilization for a time period, measured as a percentage; the value of the metric in use divided by the 
total available resources for that metric, multiplied by 100.
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